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LSynth 3.0

Para la fecha de publicación de la última entrega de 
este tutorial acababa de publicarse la versión 4 de 
LSynth que trae algunas novedades muy 
importantes. Algunas se pueden ver a primera vista: 
hay más tipos de sintetizaciones disponibles y hay 
nuevas piezas para definir el transcurso de las 
piezas a sintetizar. Pero también cambios muy 
importantes en las entrañas del programa que lo 
hacen mucho más flexible. Antes que nada explicaré 
cómo instalarlo ya que en este momento es un 
proceso en tres fases.

Instalar LSynth 3.0 

Instalar LSynth 3.0[1] requiere algo más que 
descargar e instalar el ejecutable que se puede 
descargar aquí: [2] Para poder utilizar todas las 
nuevas funcionalidades de LSynth hace falta 
descargar un archivo con las nuevas guías [3] que 
sirven para poder insertar algunas de las nuevas 
piezas que se pueden sintetizar. Estas guías son 
piezas no oficiales así que tal vez quieras colocarlas 
en la misma carpeta que las demás piezas no 
oficiales que tengas instaladas. Tal vez quieras 
instalarlas en una carpeta separada 
(Unofficial\LSynth) pero recuerda reflejar eso en 
MLCad.ini para que luego aparezcan en la paleta de 
MLCad. Las piezas de guía son las siguientes:

LS01.dat - LSynth Constraint Part - Type 1 - "Hose" 
LS02.dat - LSynth Constraint Part - Type 2 - "Hose" 
LS03.dat - LSynth Constraint Part - Type 3 - "Hose" 
LS04.dat - LSynth Constraint Part - Type 4 - "String" 
LS05.dat - LSynth Constraint Part - Type 5 - "NXT 
Cable" 
LS06.dat - LSynth Constraint Part - Type 6 - "Power 
Functions Cable" 
LS07.dat - LSynth Constraint Part - Type 7 - "Chain 
Start" 
LS08.dat - LSynth Constraint Part - Type 8 - "Chain 
End" 
LS09.dat - LSynth Constraint Part - Type 9 - “RCX 
Cable”

Además se instalarán los siguientes elementos que 
ayudarán a sintetizar las piezas flexibles:

LS10.dat - LSynth Electric Cable Segment 
LS11.dat - LSynth Electric Cable Segment NXT 

LS20.dat - LSynth Technic Pneumatic Hose - End 
Piece 
LS21.dat - LSynth Technic Pneumatic Hose - Cross 
Section 
LS30.dat - LSynth Electric Technic Fibre Optics - 
End Piece
LS40.dat - LSynth Technic Flexible Axle - End Piece 
LS41.dat - LSynth Technic Flexible Axle - Cross 
Section  
LS50.dat - LSynth Technic Flex-System Hose - End 
Piece  
LS51.dat - LSynth Technic Flex-System Hose - 
Cross Section 
LS60.dat - LSynth Short Straight String Segment 
LS70.dat - LSynth Electric Power Functions Cable 
Segment

Finalmente hace falta poner MLCad.ini a punto para 
que pueda trabajar con la nueva versión de LSynth. 
Si no has hecho ningún cambio antes en MLCad.ini 
puedes simplemente descargarlo [4] y sustituir tu 
actual versión de MLCad.ini por este. De lo contrario 
conviene tomar nota de los cambios que has hecho 
anteriormente (si has seguido este tutorial tendrán 
que ver con la localización de las piezas no 
oficiales) y aplicarlas en la nueva versión de 
MLCad.ini. Además de la información necesaria 
para LSynth y la localización de las carpetas donde 
están las piezas este fichero contiene mucha 
información para el generador de minifigs que se 
actualiza (amplía) periódicamente.
La última versión de MLCad.ini ya viene preparado 
para que puedas definir la localización de las piezas 
no oficiales y de las guias para LSynth de manera 
muy sencilla. Hacia el final del fichero encontrarás 
las siguientes líneas:

1 = SHOW <LDRAWDIR>Parts
2 = HIDE <LDRAWDIR>P
; 3 = SHOW <LDRAWDIR>Unofficial\Parts
; 4 = HIDE <LDRAWDIR>Unofficial\P
; 5 = SHOW <LDRAWDIR>Unofficial\LSynth

Basta con eliminar el punto y coma delante de los 
números 3,4 y 5 para tenerlo todo a punto.
Finalmente habrá que definir la localización de 
LSynth  en la siguiente línea:

[LSYNTH]
%PATH = "Define absolute path to LSynth"
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Por ejemplo de la siguiente manera: 

%PATH = "C:\Programs\LSynth"

¡Ya estamos listos ara empezar!

Primeros pasos

Como se ha podido observar en la lista de nuevas 
piezas guía, hay muchas más posibilidades de 
sintetización con esta nueva versión de LSynth.  En 
total hay ahora 18 posibilidades preparadas:

Del tipo tubo o cable:

01 - ELECTRIC_NXT_CABLE
02 - ELECTRIC_POWER_FUNCTIONS_CABLE
03 - ELECTRIC_RCX_CABLE 
04 - FIBER_OPTICS_CABLE
05 - HOSE_FLEXIBLE
06 - MINIFIG_CHAIN
07 - STRING_HOSE
08 - TECHNIC_AXLE_FLEXIBLE 
09 - TECHNIC_FLEX-SYSTEM_CABLE
10 - TECHNIC_FLEX-SYSTEM_HOSE

11 - TECHNIC_PNEUMATIC_HOSE
12 - TECHNIC_RIBBED_HOSE 

Del tipo cinta/oruga/cadena cerrada

13 - RUBBER_BAND
14 - RUBBER_BELT
15 - TECHNIC_CHAIN_LINK 
16 - TECHNIC_CHAIN_TREAD
17 - TECHNIC_CHAIN_TREAD_38
18 - TECHNIC_TREAD

Como se puede observar las posibilidades son 
mucho más amplias ahora y ya incluyen las nuevas 
orugas (TECHNIC_CHAIN_TREAD_38) las cuerdas 
(STRING_HOSE) y las cadenas de los minifigs 
(MINIFIG_CHAIN). Sin embargo, aunque figura el 
fiber optics cable, esto solo hace referencia al tipo 
de cable Fiber Optics x165 que vino por ejemplo con 
el Space Shuttle 8480, pero no al x400 que vino con 
el RCX, los Spybots y algunos de los sets de 
Exoforce. Sin embargo la nueva configuración de 
LSynth, al no traer las definiciones de las 
sintetizaciones incrustadas en el mismo programa 
pero depender del archivo lsynth.mpd permite añadir 
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nuevos tipos de piezas y manipular la forma de 
representarlas con las piezas existentes. Para seguir 
con el ejemplo dado, la definición del Fiber Optic 
Cable que trae lsynth.mpd es la siguiente:

FILE FIBER_OPTICS_CABLE.ldr
0 FIBER_OPTICS_CABLE SYNTHESIS DEFINITION
0 Name: FIBER_OPTICS_CABLE.ldr
0 Author: Kevin L. Clague
0 Unofficial Model
0 SYNTH BEGIN DEFINE FIBER_OPTICS_CABLE 
HOSE STRETCH 2 50 0
0 ROTATION CENTER 0 0 0 1 "Custom" 
0 ROTATION CONFIG 0 0
1 0 0 0 0 2 0 0 0 1 0 0 0 2 4-4cyli.dat
1 0 0 0 0 2 0 0 0 1 0 0 0 2 4-4cyli.dat
0 // LSynth Electric Technic Fiber Optics - End Piece
1 28 0 0 0 1 0 0 0 1 0 0 0 1 S\LS30.dat
0 SYNTH END

El Fiber Optics Cable x400 es más ancho y no tiene 
un extremo distinto del otro. Si te fijas en las 
diferencias con la siguiente configuración que Philo 
sugirió para esta pieza verás que jugando con los 
parámetros y eliminando las dos penúltimas líneas 
se puede crear fácilmente un 'nuevo' tipo de piezas 
flexible en LSynth:

0 FILE FIBER_OPTIC_CABLE.ldr
0 FIBER_OPTIC_CABLE SYNTHESIS DEFINITION
0 Name: FIBER_OPTIC_CABLE.ldr
0 Author: Kevin L. Clague
0 Unofficial Model
0 SYNTH BEGIN DEFINE FIBER_OPTIC_CABLE 
HOSE STRETCH 8 50 0
0 ROTATION CENTER 0 0 0 1 "Custom"
0 ROTATION CONFIG 0 0
1 0 0 0 0 4 0 0 0 1 0 0 0 4 4-4cyli.dat
1 0 0 0 0 4 0 0 0 1 0 0 0 4 4-4cyli.dat
1 0 0 0 0 4 0 0 0 1 0 0 0 4 4-4cyli.dat
0 SYNTH END

En vista de esta flexibilidad mediante la edición del 
archivo lsynth.mpd conviene actualizarlo 
periódicamente para sacar el máximo partido de las 
mejoras y/o ampliaciones que se pueden hacer a 
través de este archivo. El uso de la herramienta no 
varía más que en la variedad de piezas disponible y 
en que hay guías específicas para ciertos tipos de 
piezas y para eso puedes consultar la 4ª entrega de 
este tutorial.

LDview

Hasta ahora hemos hablado casi exclusivamente de 
las herramientas disponibles a través de la interfaz 
de MLCad. Sin embargo el mundo de LDraw es 
mucho más amplio que eso. Además de una 
biblioteca de piezas virtuales, las herramientas que 
componen el entorno de LDraw se pueden dividir a 
groso modo en tres categorías: 

- herramientas de construcción
- herramientos de visionado
- herramientas de publicación.

¿Acaso MLCad no cumple las tres funciones? De 
manera muy limitada efectivamente hace esto: 
permite construir un modelo, pero también permite 
visionarlo en 3D y ver los pasos de los que consta el 
fichero LDraw. Sin embargo, en estas dos últimas 
tareas la calidad de MLCad es muy limitada y hay 
otras herramientas - igualmente sencillas de 
manejar - que dan un resultado mucho mejor.

Como su nombre ya indica, LDView es una 
herramienta de visionado (o renderización) de 
archivos LDraw. Permite ver las construcciones 
virtuales en 3D con buena calidad sin necesidad de 
muchos recursos (procesador, memoria) y ajustar 
los parámetros del visionado al gusto de cada uno. 
¡Además está disponible tanto para Windows como 
para Mac y Linux!

Instalar LDView

La instalación de LDView no guarda ningún secreto 
pero merece la pena detenerse en algunos ajustes 
que permitirán disfrutar de renderizaciones de 
mayor calidad.
El programa se puede descargar de la página 
dedicada a esta herramienta [6]. Selecciona la 
versión que corresponde a tu sistema operativo y 
una vez descargado instálalo. La primera vez que 
inicias el programa te preguntará si tienes la 
biblioteca de piezas LDraw instalada y, de ser así, 
donde. Si indicas que no lo tienes instalado LDView 
descargará la biblioteca LDraw para poder 
funcionar. 
Como es posible que además de las piezas oficiales 
tengas piezas no oficiales existen dos opciones. 
Puedes permitir a LDView que descargue las piezas 
no oficiales que vaya necesitando. También puedes 
indicar la(s) carpeta(s) adicional(es) donde LDView 
debe mirar para encontrar estas piezas en tu 
ordenador. Para ello tienes que ir a File > Extra 
Dirs... y pinchar en el icono con la leyenda "C:\" que 
se encuentra en la parte inferior de la ventana 
emergente. A continuación puedes seleccionar la 
carpeta que contiene tus piezas no oficiales (por 
ejemplo C:\LDRAW\Unofficial). Por supuesto puedes 
usar las dos opciones conjuntamente.

Configurar LDView

Se accede a la pantalla de configuración de LDView 
a través del menú Edit > Preferences (o 
Ctrl+May+P). Los siguientes elementos merecen 
especial atención ya que mejoran sensiblemente la 
calidad de la imagen final. Sin embargo, como 
siempre, hay que buscar el equilibrio entre calidad y 
manejabilidad (a mayor calidad más compleja la 
renderización y menor el tiempo de repuesta del 
ordenador) aunque los equipos modernos no suelen 
presentar problemas en este área.
En la primera pestaña (General) conviene 
seleccionar el mayor valor de FSAA (Full Scale Anti 
Aliasing) disponible además de marcar la casilla 
"Antialiased lines". 
En el cuadro "Colors" puedes elegir el color de 
fondo que usará LDview. Los valores de Default y 
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Transparent sólo sirven cuando se visionan piezas 
individuales de la biblioteca LDraw.
En el cuadro "Misc" hay dos opciones que merecen 
especial atención: "Process ldconfig.ldr" y "Show 
errors after loading". La primera opción merece una 
explicación más a fondo en una próxima entrega, y 
"Show errors after loading" es muy útil para detectar 
porqué un archivo LDraw no se visiona como lo 
esperábamos, dando información sobre piezas o 
archivos que faltan.
El cuadro "Default Save Directories" permite 
seleccionar dónde serán guardadas las 'fotos', listas 
de piezas o el modelo, pudiendo elegir entre la 
carpeta en la cual se encuentra el modelo que 
hemos abierto (Model), la última carpeta que se ha 
abierto (Last saved...), o una ubicaión a especificar 
en las preferencias (Specified).
Las opciones de la pestaña Geometry que nos 
puedan interesar son accesibles desde la interfaz 
principal y es más práctico probar la configuración 
que más te guste desde allí. Lo mismo sucede con 
la pestaña Effects aunque aquí podemos resetear la 
dirección de la luz de forma sencilla.
Conviene seleccionar "Primitive substitution" en la 
pestaña Primitives. Esto permite a LDView usar sus 
propios primitives[7] lo que puede resultar en una 
renderización más natural y menos angulosa. 
Además, solo de esa manera tendremos acceso a 
"Texture studs". Nuevamente cuanto más avanzada 
la opción que seleccionemos aquí (cuanto más 
abajo, más avanzado) mejor se renderizará, aunque 
con el consiguiente 'coste'. La opción "Curve quality" 
permite graduar el número de facetas que se 
emplean para dibujar una curva. Si visionamos un 
stud en MLCad observaremos que no es redondo y 
tiene 8 caras. Mediante esta opción es posible hacer 
estas partes más curvas, pero hay que usar la 
opción con cuidado ya que a veces puede causar 
efectos no deseados. Las opciones "Primitive 
substitution" y "Texture studs" también están 
disponibles en la interfaz principal.
La pestaña Updates presenta la opción 
"Automatically check LDraw.org for missing parts". 
En el caso de que no tengas instalado una pieza 
necesaria para ver un modelo, LDView lo intentará 
descargar del Parts Tracker de LDraw.org de forma 
automática. Si por alguna razón LDView no consigue 

conectarse a internet, esta opción se deshabilitará 
auntomáticamente y será necesario seleccionarla 
manualmente si queremos volver a usarla.
Finalmente, la pestaña Preference Sets da acceso a 
una serie de conjuntos de preferencias 
preconfiguradas que pueden servir de base para 
conseguir la configuración óptima para nuestras 
propias necesidades. También es posible guardar tu 
propio conjunto de preferencias e incluso se puede 
asignar un atajo de teclado (hot key) para cargar tus 
preferencias de forma fácil y rápida.

Manejar LDview

El manejo de LDview es muy intuitivo. Basta cargar 
un archivo LDraw para que aparezca la 
renderización en pantalla, y arrastrándolo con el 
ratón conseguirás verlo desde cualquier ángulo. A 
veces cuesta un poco conseguir el ángulo que se 
desea en las tres direcciones. Esto es debido a se 
gira alrededor de un punto fijo que no se puede 
cambiar. Para facilitar en la medida de lo posible el 
poder encontrar el ángulo que querramos existen 
varias ayudas. Una de ellas son los atajos de 
teclado Ctrl más 0-6 con los cuales conseguiremos 
la visión (en este órden) "dos-tercios" (con la que 
LDview abre por defecto) frontal, trasera, izquierda, 
derecha, superior e inferior. Ctrl+9 además nos 
permitirá elegir el ángulo específico además de la 
distancia a la que queremos colocar el modelo.

Para ver la renderización más de cerca (o de lejos) 
podemos además usar la rueda del ratón o la 
combinación botón derecho más arrastrar. 
Asimismo, pulsando Ctrl+Alt y arrastrando el 
puntero, podemos mover todo el modelo lo cual es 
muy útil para poder enfocar en un detalle específico 
de una construcción.
A veces al visionar una construcción con LDview 
nos damos cuenta de que falta algo o hay algún 
elemento mal colocado o que para poder ver 
correctamente una parte determinada debemos 
ocultar parte de la construcción. Si abrimos MLCad 
u otro editor y corregimos el problema solo hace 
falta pinchar en el tercer botón desde la izquierda en 
la barra de iconos y el archivo se volverá a cargar 
con los cambios que se han guardado.
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El siguiente grupo de iconos da acceso a algunas de 
las opciones que ya hemos visto en la configuración 
de las preferencias. Os animo a probar cada una de 
ellas y ver cómo afecta a la renderización del 
modelo que estáis viendo.
Finalmente hay un grupo de opciones en la barra de 
iconos (después de 'Step:') que son nuevas en 
LDview 4. Permiten ver los pasos que se han 
incluido en el archivo LDraw, lo que puede ser útil 
tanto para reconstruir un modelo del que tenemos 
las instrucciones como para sacar imágenes de 
buena calidad para crear unas instrucciones paso a 
paso. 
Otra novedad en esta versión de LDview es que 
además de los pasos es posible ver los archivos 
individuales que componen un MPD. Para acceder a 
esta función solo hay que pinchar en "Tools > MPD 
model selection" (Ctrl+M) y elegir en la ventana 
emergente qué parte del MPD queremos ver.
LDView también permite, de forma sencilla, cambiar 
la iluminación de un modelos. Para ello mantener el 
botón Mayúscula (Shift) pulsado mientras arrastras 
el puntero del ratón. Si no consigues la iluminación 
que desaes siempre puedes volver a los ángulos de 
iluminación en la pestaña Effects de Edit > 
Preferences.

Más información

Pero allí no termina todo. LDView nos puede dar 
mucha más información. Así puede generar un 
listado de piezas empleadas en el modelo en 
formato HTML. Esta lista puede incluir información 
como el número de cada pieza, su color, cantidad y 
descripción y permitir acceder a una imagen de la 
pieza en Peeron.com. 
Otro tipo de información que LDView da es la 
relacionada con el ángulo de la cámara para su uso 
posterior en Pov-Ray, un renderizador mucho más 
potente pero a la vez mucho más complejo de 
utilizar. 

Salvapantallas

Por último, LDView presenta la opción de instalarse 
como salvapantallas. Esta opción se puede marcar 
durante la instalación, pero si se te ha pasado por 
alto, no pasa nada. Puedes reinstalar LDView sin 
tener que desinstalar antes y además conservará 
todos los ajustes que hayas hecho antes. La 
configuración del salvapantallas se hace, al igual 
que la de cualquier otro salvapantallas desde 
"Propiedades" del escritorio en la pestaña 
salvapantallas.
Después de toda esta información solo puedo hacer 
una recomendación: prueba, prueba y prueba. 
LDview es sencillo de manejar y seguro que 
después de unos pocos intentos consigues el 
resultado que deseabas. Si tienes más preguntas o 
sugerencias siempre puedes hacerlas llegar a través 
del foro HispaLUG[8].

[1] hay otro tutorial completo disponible en 
www.holly-wood.it/lsynth/tutorial-en.html que 
además incluye los links a todas las descargas 
necesarias.
[2] www.kclague.net/LSynth/index.htm
[3] www.holly-wood.it/files/lsynth/Constraints.zip
[4] www.holly-wood.it/mlcad/ini-en.html
[5] www.holly-wood.it/lsynth/tutorial-en.html
[6] ldview.sourceforge.net
[7] Los 'primitives' son partes de piezas que se 
reciclan y reutilizan en muchas de ellas. Por 
ejemplo, cada stud es un archivo independiente, que 
el archivo que describe un brick utiliza las veces que 
haga falta.
[8] www.hispalug.com
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